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Before You Start 

THIS IS IMPORTANT!  

The Hyperion EOS Control & Data Suite adds the convenience of a PC software interface to the control 

interface of the Hyperion chargers that have PC connectivity, plus a rich data plotting and export functionality 

for the charger results. It does not alter the fundamental operation and behaviour of the charger. Accordingly it 

is important that you fully read the charger manual and understand the operation of the charger before 

using the software. Hyperion chargers are extremely sophisticated and powerful tools. They have been 

designed to be as foolproof and fail-safe as possible but power and complexity come with a cost. It is possible 

to maltreat your battery by the choices you make in configuring the charger – either from the control panel or 

from this software. Wherever possible, defaults are set to avoid this but the responsibility is yours to ensure you 

operate the charger correctly.  

This software requires Hyperion EOS Firmware 5.5 or later.  

Visit the EOS CHARGER Firmware Update site for the newest version: 

https://hyperion-world.com/en/firmware_for_eos_line_chargers  

The software itself can be downloaded at: https://hyperion-world.com/download_files/manuals/Installer.zip  

Setting up the Charger 

There are three series of Hyperion chargers that work with this software.  

1. The current Duo and Net chargers EOS 0615i DUO3, EOS0720 Super Duo3, EOS 0720i NET3, 0720i NET3-AD 
(AC/DC) and EOS 1420i. These chargers have a PC connection and the interface to allow full control by this 
software suite and the data functions. They have a built in USB interface and do not require an adapter to 
connect to a USB port, only a USB cable. 

2. The second generation Duo charger EOS 0610i DUO2 and EOS 0720i NET. These chargers have a PC connection 
and the interface to allow full control by this software suite and the data functions but do not have a built in USB 
connection. Requires the adapter and harness below. 

3. The original chargers EOS 0610i DUO (the Duo 1) and 0606i-AD (AC/DC) have a PC connection but do NOT have 
the internal hardware interface to allow control of the charger by this software suite. We suggest the EOS 
INSIGHT for logging with these chargers. 

Chargers listed in (2) above require the USB/Serial adapter and the correct harness. ALL chargers require the 

Silicon Labs driver kit for the USB/Serial interface obtainable from the link on this page:  

https://hyperion-world.com/en/hpconnect  

where it says;  

Click here for HP-TI-PRGUSB Driver Download and Instructions  

https://hyperion-world.com/en/firmware_for_eos_line_chargers
https://hyperion-world.com/download_files/manuals/Installer.zip
https://hyperion-world.com/en/hpconnect
https://hyperion-world.com/en/hyperion_usb_drivers
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Mac User? 

This software is designed to work on Windows XP, Vista and Win7.  It has been tested successfully on all three 

of these running in Parallels or VMware Fusion on a Macintosh under OS 10.6 as well as BootCamp.  

Additionally it has been tested on Windows 10.  See Troubleshooting for some comments on USB/Serial ports, 

particularly on the Mac. The data files produced by the software using the export functionality are in XML 

format and directly usable by Mac software that can read this format. For example: Office and iWork.  

Hardware connection 

Most current Hyperion EOS chargers have a built in USB connection. Simply use the supplied cable to connect 

to a free USB port on your computer.  For the chargers listed under 2) and 3) above you need the Hyperion 

USB/SERIAL Adapter Cable and a HP-EOS06-PCCBL or HP-EOS0606-PCCBL wiring harness depending on 

your charger.  

 

Figure 1 

#HP-TI-PRGUSB: Hyperion TITAN USB/SERIAL 4-Pin Adapter Cable  

(Note the small adapter at the bottom of Figure 1 is discarded. It is for the obsolete Emeter1 only)  

This adapter is used for connecting EOS CHARGERS to the PC Port for:  

 EOS 0610i DUOII - Firmware upgrades and PC Software with full logging and control 
 EOS0610i NET, DUO, 0720i NET - Firmware upgrades and PC Software for logging 
 EOS0606i DC and AC/DC - PC Software for logging 

Wiring harness 

The HP-TI-PRGUSB cannot be connected directly to EOS Chargers. A wiring harness/extension is needed 

between the charger and USB Adapter:  

HP-EOS06-PCCBL harness for PC Logging and Firmware Update: 

EOS0610i-NET 

EOS0610i-DUO 

EOS0720i-NET 

EOS0610i-DUO2 (Full PC Logging and control)  
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HP-EOS0606-PCCBL harness for PC Logging Only 

EOS0606i-AD (ac/dc, all versions) 

EOS0606i (dc, all versions)  

Getting Started 

1. Download and extract the software but do not run it yet. Read the Readme file if there is one. 
2. Download and run the Silicon Labs driver kit which will install a Serial port that the software can address through 

a USB port. 
3. Connect the charger to the PC via a USB lead (and adapter if applicable). Windows will install the driver if this is 

the first connection 
4. Go to Device Manager* and check under Ports. There should be a device called Silicon Labs CP210x USB to UART 

Bridge (Com n) where n will be a number. It is often 3 but may be something else. This is the Com Port number 
the software will use. 

5. Connect the black (-ve) lead of the charger to the power supply or field battery. 
6. Turn on your power supply if required. 
7. Connect the red (+ve) lead of the charger to the power supply or field battery. The reason for doing it in this 

order is that in rare cases it is possible to damage the computer by connecting a high current device that also 
has a USB port. See below. 

8. Run the software. The charger should appear in the “Chargers detected” window. If not, go to the File menu in 
the top left hand corner and re-initialize the charger. If the Com Port is not found see Troubleshooting. 

* If you don’t know where Device Manager is, see this 

http://pcsupport.about.com/od/tipstricks/f/finddevmngr.htm  

Why you should connect the +ve supply lead last. 

When you connect a DC Powered unit to your computer, it's important to know that a circuit may exist for 

current flow even if the –ve is disconnected between the power supply and the charger. This can happen if the 

AC power has a ground connection to the computer and the charger power supply. If the –ve outlet of the power 

supply is grounded, current can “sneak in” backwards via the Computer and USB connection. In the first 

schematic below, Figure 2, the current flows from the power supply to the charger through the red +ve wire and 

back through the black –ve one as expected. In the second diagram, Figure 3, the charger could be running even 

if the -ve is cut between the power supply and chargers, because it can take a back route via the ground wire of 

the AC outlet -> Computer ->USB ->Charger as shown by the path in purple. There is a possibility that a high, 

charger level, current could flow through the USB circuitry which was never designed for that.  

http://pcsupport.about.com/od/tipstricks/f/finddevmngr.htm
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Figure 2 

Always connect the NEGATIVE side of the charger first! 

Otherwise if the various power and USB –ve wires are connected to ground internally, the inrush of current can 

go the wrong way (through the computer), and can possible burn your USB controller on the Computer.  

 

Figure 3 
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The Main Screen 

Welcome 

Welcome to the EOS Control & Data Suite manual.  

The EOS Control suite is a program that allows you to take control of your Hyperion EOS charger via your 

computer, including keeping records of your charges and to be able to create powerful graphs.  

Use the menu to the left to navigate between the different functions of the program, Figure 4.  

 

Figure 4 
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The Main Screen 

The Main Screen is where the software first starts. The File menu on this screen is the place to select Exit to 

close the software. Note that the software automatically checks for a new version at startup. If you start then 

instantly press X from Windows to exit, the software may appear to freeze until the checking process is 

complete.  

Charger detection 

When the software starts, your Charger should appear in the Chargers (detected) box in the top left hand 

corner. If not, then go to the File menu and select Re–Initialize chargers (run startup again) AFTER you 

restart the charger and connect/disconnect the USB. If this does not find the charger, then you have a COM port 

issue. See “Troubleshooting” in this help about checking which COM port your computer is using and then see 

Manual COM Port selection if automatic doesn’t work. You use Manual COM port selection in the File menu 

to select a COM port if necessary.  

Figure 5 is typical.  In the Top Left hand side box you have a list of chargers with all the functions the software 

has for each. A Duo charger will show as a single entry with each channel listed underneath it. Click on the + 

sign to expand the two channels of a Duo and click on the + sign for each channel to get the functions. A non-

duo like the 720iNET, even if networked, will show as a single charger. Figure 6 shows two EOS 0720i NET3 

chargers connected. One is on COM 6 and one on COM7. A Duo charger will have a similar display but uses 

only the one COM port. If you have more then one charger, please read this before starting. Note that you can 

Right Click to change the name of the charger from the default. See Configure Alarms in this help for an 

example of where this is useful.  

 

Figure 5 

http://hyperion.dacsa.net/COMPortselection.htm
http://hyperion.dacsa.net/Twoormorechargers.htm
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The bottom menu Log viewer takes you to the display screen that is the normal one you use when the charger is 

running. The screen will switch to the Log view automatically when a charge/discharge starts. Log view shows 

the voltage of every cell in a different color graphed against elapsed time. For cells 8-14 on the EOS1410 the 

lines are dotted.  

 

Figure 6 

The Bottom Left Hand side box has an overview of critical information for all chargers that are connected and 

running.  

For example it will show cell voltage gap (color coded black/green/yellow/red for severity in 10mV steps) and 

TCS%.  

In the main screen, if a charger loses the connection to the software for some reason, after 5 seconds it will 

disappear from the chargers (detected) list. 

When connection is restored, the text will return to normal again.  

When a charge or discharge is running, the active channel text (or channels if multichannel) will turn Green for 

Charging, Red for discharging and Blue for unknown for the time before it knows which direction, no figure 

needed. 
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The other main menu is Tools, including: configure alarms, charger pairing window, charge statistics, show 

master-overview, enable single control network mode and adjust command time offset (slow computers). 

Here you can configure the various alarms, including setting the text that the computer will use to announce 

charger events.  See - Alarms, Set alarm for different type of events.  

You can also see a quick view of the “charge history” database where every piece of sampled data is stored, 

filtered to show only a single pack if required.  There is more information at Database quick View (show a 

quick view of the logging database).  

The last item in the top half is the menu which allows you to set up two chargers as a single pair (you need a 

separate USB connection for each) and control them as one. See Charger pairing.  

The bottom part of the window has some less-used functions:  

Most importantly, access to the database under Charge Statistics. Here you can view the whole history of the 

software in use, filter by pack name or any tags you have set, delete any unwanted records, and export selected 

charge records in XML format which can be read by many other programs, usefully the Microsoft Office suite 

and iWorks. The View Details button will take you to a window where you can select several useful graphs of 

Pack and Cell Voltage, IR and TCS level for any record in the database.  

In Charge Statistics, if you are using a Duo to Synch Charge, the Channel 2 statistics are displayed in blue and 

if no specific tag is entered for Channel 2 the tag from Channel 1 is used.  

  

http://hyperion.dacsa.net/Alarms.htm
http://hyperion.dacsa.net/DBQuickView.htm
http://hyperion.dacsa.net/DBQuickView.htm
http://hyperion.dacsa.net/Chargerpairing.htm
javascript:gotoTabLevel2('#charge_statistics');
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Alarms 

From the Tools menu in the Main screen you can access the Configure Alarms window, Figure 7. You can 

enable or disable an alarm for each of four functions.  

Alarm configuration 

 

Figure 7 

 Begin charge will sound when the charger starts a charge or discharge 
 End charge will sound when the charger ends a charge or discharge 
 Error occurred will sound if the charger detects any error condition 
 Out of sync will sound if two chargers which are set to Synch Charge have too much of a voltage gap between 

the cells. That gap can be selected. (Synch charge differs from charging two batteries independently on a Duo 
only in that the balance readings are combined and the two are treated as a single battery made up of the two 
in series. The Duo will attempt to balance all the cells as though it were a single pack.)  

Using Action, the alarm can either be a WAV sound file OR it will play the text you write as speech.  

You can choose a suitable alert as the WAV file in the Filename or Text box– there are many examples on the 

Internet. Alternatively you can insert text.  

When using speech the default settings will add the charger name and channel number into the spoken text. 

Maximum speech time is 15 seconds.  

The Text will be spoken exactly as entered in the Filename or Text box unless you use specified shortcuts.  

The following shortcuts are available for accessing LogData to put in the the Alarms.  

 [packname] = Name of pack (from memory editor) 
 [charger] = Name of charger. 
 [channel] = Current channel 
 [mahcharged] = Total Capacity out (only valid for end of charge and error) 
 [finalvoltage] = Current output voltage. 
 [tcslevel] = Current TCS level 

As soon one or more shortcut is entered in the Alarm string, the default alarm string is abandoned, but can be 

recreated by using the text, “[chargername] on [channel] reports Begin Charge" for example.  
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Hint: It is worth changing the default name of the chargers by right clicking to something simple to say, and 

choosing simple names for the packs in the memory editor. The default EOS charger names will sound garbled.  

Sample End Charge Alarm: "[charger] on channel [channel] has completed [packname] with [mahcharged] 

capacity." Note that the Test button will read out this text literally but the variables will be substituted in actual 

operation.  

Set duration (number of times played) if you want it to repeat more than once.  

Use the PC Volume to set the volume of the alarms  

The Out of sync can be configured to raise the alarm at a given "cell voltage gap" (preset in the picture to 

0.100)  
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COM Ports Selection 

From the File menu in the Main screen you can access the Manual COM Port selection window.  

The box, Figure 8, will show all the COM ports the software recognizes which is possible to be chargers.  

 

Figure 8 

Note: The COM port selection screen is only needed if the automatic COM port check does not work or takes 

too long. See Troubleshooting for more information  

  



15 
 

Two or more chargers 

When you connect two or more chargers, you MUST go through this procedure. This applies whether or not 

you choose to pair them.  

1. Connect one charger only, start the program and press Yes on the questions about changing serial ID 

2. Unplug the charger, close the program. 

3. Plug in the second charger, start the program and again, press Yes on the questions. 

4. Unplug the second charger, close the program 

5. (repeat if you have more chargers) 

6. Plug in all chargers and start the program. 

See Charger pairing if you want to set up two chargers as a single pair.  

Note: When running more than one EOS0720 chargers you MUST have one USB cable to each charger even if 

they have a network cable connecting them  

  

javascript:gotoTabLevel2('#charger_pairing');
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Charger Pairing 

When you have two or more chargers which are bound to each other via a network cable (Hyperion Network 

cable) you can group them in the EOS Control & Data suite.  

It is not mandatory to do so, but grouping can you a better overview of how your chargers are physically 

arranged.  

When you start the program you get Figure 9 automatically if it detects more than 2 chargers which are 

connected.  

If you do not want to pair chargers and want to skip this step in future, just click the "Don’t show this box at 

next startup" and press Continue.  

 

Figure 9 

To group two chargers together, CTRL-Click the two of the chargers which you want to create a group for.  
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If you are unsure which charger is which, highlight one of them, right click the mouse and select identify, now 

look at the LCD display of the chargers.  

The one you selected to identify will now switch between memory 1-2-3-4-3-2-1 for a 4 second period.  

When you have selected the correct chargers, right click and select Pair.  

The software will then create a "master" node which contains both chargers.  

If you wish to break a pair you can right click on the master and select Break.  

The result will look like Figure 10 

 

Figure 10 

You can rename the "master" in a later stage in the main screen to a name of your liking.  
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Also, if you want in a later stage to access this window it can be accessed at any time from the Tools menu of 

the main screen.  

The charger you select first will be the Channel 1 charger; the second will be Channel 2  

Please note, if you choose not to pair a networked pair of chargers, there will be double entries in the database 

for each charge, since one of the chargers will report a duplicate set of readings as its own Channel #2, and the 

other as its Channel #1.  
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Charge statistics 

The charge statistics shows you every charge you have made with the charger when the EOS Control & Data 

suite program has been running, Figure 11.  

 

Figure 11 

Blue lines indicate "second leg" of a SYNC charge.  

You can choose to filter the list on pack name or tag. 

You can right-click an item and press View detail, Export selected, or delete the selected item. 

(For multiple deletions at once, select multiple records using CTRL or SHIFT click)  

Pressing View details brings up the graph window, Figure 12.  
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Figure 12 

There is a range of selections of different graphs that can be made, Figure 13. 

 

 

Figure 13 

In the bottom you have a "User defined" selection, which enabled a link to the User defined configuration.  

Then you can add your own axis to the graph, Figure 14. 
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Figure 14 

and get results like Figure 15;  
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Figure 15 
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Advanced graphing 

If you would like to do more advanced graphing, you can do this using the Export function of the Hyperion 

EOS Control & Data Suite.  

Under the Charge statistics module you can select a charge and press "Export selected" 

This will give you the option to export to XML format (readable by Excel 2007 and later) or TAB delimited 

Text file (which you can read into any graphing program, like the Logviewer which can be found here: 

http://www.logview.info/cms/d_download-logview.phtml)  

If you have knowledge of SQL language, the data itself is stored in a SQLite database under 

Documents\hyperion\EOSLogging.s3db  

SQLite: http://www.sqlite.org/  
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User Setup 

Here you set up various operating parameters of your chargers and power supplies. You need to refer to your 

manuals to obtain the correct settings. The software has no way of knowing what some of these should be (for 

example the power supply voltage and current capacity) and it is possible to force the software to accept values 

that are not supported by a particular charger/power supply combination. It is your responsibility to ensure that 

sensible values are input. Importantly, only change LiPo Max C if you know what you are doing. The charger 

default values are applicable to most normal situations but use this screen to optimize them to your needs if 

necessary.  

Personal Preferences 

 

Figure 16 

The top five settings, Figure 16, are simply to set your preferences. The finishing sound melody can be set to be 

different if you have multiple chargers running at once. Deciding which sound you prefer is most easily done by 

just trying each one out in turn using the buttons on the charger itself and choosing your preference. You can 

also set a PC alarm for this event in the Configure Alarms menu.  

Charger Limits 

The bottom four, Figure 17 settings control important electrical characteristics and should be set with care. 

 

Figure 17 

In particular LiPO Max C should not be changed unless you are sure that your cells (such as the 

Hyperion G3’s) can safely be charged at higher rates. This setting limits the maximum charge rate that 

can be set in the memory setup only for a LiPo or LiIo battery. It is not applied to other chemistries so 

you can for example charge A123, NiMH or NiCd batteries at high C rates even if this limit is set lower. 

Hyperion advises that if you don’t know the allowed max charge rate for your LiPo/LiIo pack, never 

exceed 1C rates. The other three settings should match your Power supply characteristics and how you want to 

set the shared power percentage for the two battery outputs on a Duo charger.  



25 
 

New for Firmware v5.0 or later is that LiPo Max C now allows up to 6C  
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Memory Setup 

Here you can edit each memory in the charger, Figure 18. 

 

Figure 18 

You can name a memory by text, it will not show on the charger but it will show in the PC program.  

You can also backup and restore to file. This is very useful if you want to configure multiple chargers as you 

can create one file with a set of memories, save it using Backup to File then Restore from File for each 

charger in turn. 

All chargers that using Firmware 4.1 or later can have the same memory setup, so you can save/restore cross 

model.  

As of v5.0 or later, memory is stored per memory number in the Charger, previous generic key solution has 

been replaced.  

You can Copy/Paste memory by right click in the list of memories to the right.  
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Cache to Disk/Remove Cache 

This function will cache the memory to disk, making the Control Charger function to load instantly. 

If you edit a memory you have to re-cache the setup, if you change a memory on the LCD you will get a 

warning when you try to charge that the memory has been changed.  

Show overview gives you a grid like overview of all memories, non editable, Figure 19. 

 

Figure 19 

 New for firmware 5.0 is that you can (default on) write the Pack name to the charger, it will show in the LCD. 
 It allows up to 15 characters. 
 If you do not want to change the name in the charger, uncheck the checkbox before you write the changes, 

Figure 20. 

 

Figure 20 

When updating the pack name in the memory editor the field turns red if you write more than 15 characters as 

an indicator it will be truncated if you choose to save it to the charger.  
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Charge/Discharge 

You can either control it for  

 Charge/Discharge/Store/Balance 

 Cycle  

  

javascript:gotoTabLevel2('#control_charge');
javascript:gotoTabLevel2('#control_cycle');
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Control – Charge/Discharge/Store/Balance 

 

Figure 21 

In Figure 21, under “Chargers (detected),” pick a Machine/Channel then select “Control Function.”  In the 

center section lower half, if a battery is connected, to any channel you will see the total voltage and cell count – 

cell count detected by the balance port.  NO BATTERY is possible as well, as shown in Figure 21.  These 

indicators will change, always showing the active channel to the left. 

In the upper half you choose an operation: Charge, Discharge, Storage or Balance and whether to use mode: 

Solo, Quick or Sync (if you have two chargers).  New menu items will appear depending on operation.  Cycle is 

discussed in another section of this manual. 

As you start the charge, you will see a "Stop charge button."  There is a “stop charge button” on the Log viewer 

screen as well. 

The system will warn you if you try to start a charge with wrong number of cells connected via Balancer.  

Shortcuts:  

 Pressing keys 1-0 will give you memory position 1 through 10 

 Pressing shift-1 to 0 will give you memory position 11 through 20 

 Please note that when you are in the Tagging field the shortcuts do not work. 
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32 
 

Control – Cycle 

 

Figure 22 

The Cycle option, Figure 22, allows you to choose Solo or Sync mode for the Charge and Discharge parts of the 

cycle as well as whether you want to start with a Charge or a Discharge and the total number of cycles from 1-

10. You can also set a delay time between 1 and 30 minutes between the end of Charge and start of Discharge 

(or the reverse).  
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Data View 

 

Figure 23 

This function shows various data from an active charge or previous cycles, Figure 23.  
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Log Viewer 

Figure 24 is the screen you use while the charger is actually running.  

 

Figure 24 

 

The log viewer (in this case showing 2 channels), shows you a total overview of each channel that is connected.  

Note: When viewing a networked 0720iNET setup, if you charge in sync mode both channels will show in a 

single screen (regardless of what charger you select out of the two that are networked.)  

If a charge is active you will have the Stop Charge button enabled. This does not apply for those chargers that 

are unable to be controlled from the software. See Before you start  

The Confirm Cell # button is the same as pressing Enter on the LCD of the charger, either to speed up the 

charge start process or to confirm cell count if no balancer is used.  

When a charger is active the current channel is highlighted in green, red or blue in the main tree view window 

depending on whether it is charging, discharging or waiting.  

javascript:gotoTabLevel1('#before_you_start');
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Tag this/next charge is a function to "put a label" on a specific charge, if for sample you want to name it with 

the battery name or some specific identification. The Tag this/next charge button will open a free text dialog 

box  

The log viewer stores all the logged information to a SQL Database (sqlite), so you can run external statistics on 

the chargers at a later stage, all cell voltages are included as well as the tagging. It is also possible to export 

from the database in XML format.  

You can at any time right click on a graph to save it or do other things, like Zoom which brings up the graph in 

a bigger window. Zooming is also available by dragging the cursor over the section you want to enlarge.  

The log view scales, so if you want a bigger graph or bigger text in the cell voltage screen, maximize the screen.  

 

Figure 25 

The Cell voltages screen turns yellow, Figure 25, to indicate you have connected a pack with a balance 

connector, so you can easily identify which channel is which in a multi-channel setup.  

As of version 2010-06-02 you can find a configure graph link in the upper right corner, Figure 26. 

http://hyperion.dacsa.net/Tagging.htm
http://hyperion.dacsa.net/Tagging.htm
http://hyperion.dacsa.net/Tagging.htm
http://hyperion.dacsa.net/DatabaseTable.htm
http://hyperion.dacsa.net/DatabaseTable.htm
http://hyperion.dacsa.net/ZoomGraph.htm
http://hyperion.dacsa.net/ZoomGraph.htm
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Figure 26 

When you press that link you get a selection box of what fields to show in the graph, Figure 27. 

 

Figure 27 

v2010-12-06: 

There is a new View on the Log viewer where you can see each channel's data and graph in Tabs, to access this 

press the "Switch to Tab view" link, visible in the upper of Figure 28. 
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Figure 28 

This will give you the screens shown in Figure 29 and Figure 30. 
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Figure 29 

 

Figure 30 

Use “Switch to Tab View” or “switch to normal view” to change views – they are the same link.  
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Database Table 

This is the definition of the two tables that contains all logging. This is for information only. Most users will 

have no need to reference this.  

 

Figure 31 
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Figure 32 

For each charge there ONE entry in the charge header, Figure 31, and each log output (one every second) is 

stored in the ChargeLog table, Figure 32.  The two tables are combined by the same ChargeKey key.  There are 

a total of 48 data fields collected, therefore on a subset is displayed in Figure 32 .  
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Zoom Graph 

Right clicking on a graph will open a menu, Figure 33. Choosing Zoom (bigger window) will open a larger 

graph window, Figure 34. Close it with the Windows close box X.  

 

Figure 33 

 

Figure 34 
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Tagging 

 

Figure 35 

The tagging will store a "tag" or label for a certain charge into the database, it will suggest a list of tags already 

used, Figure 35, so you can use same tag for each charge with a particular battery, this way you can get a 

complete historical statistics of "that" battery, for example: how many cycles, how its Internal Resistance (IR) 

has evolved, how much you have taken out on average, etc.  
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Troubleshooting 

Charger detection 

If you don’t get the charger showing in the main screen, do the following:  

1. Make sure you have firmware 5.0 or later. This is displayed on the Charger screen when you switch it on. 
2. Stop the program, unplug the USB cable, turn the charger off and then on again, plug in the USB cable, and 

restart the program. 
3. If it still doesn’t find it, go to the File menu and run the Re–Initialize chargers (run startup again) routine. 

If you still have trouble, make sure your charger is showing up in the "Windows Device Manager", under COM 

Ports. If you don’t know where Device Manager is, see this 

http://pcsupport.about.com/od/tipstricks/f/finddevmngr.htm for a description for various versions of Windows.  

It will look something like Figure 36 (COM 1 and COM2 are commonly reserved by Windows for the two 

physical serial ports whether they exist or not, so COM3 is the normal first additional port assignment):  

http://pcsupport.about.com/od/tipstricks/f/finddevmngr.htm
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Figure 36 

COM port issues 

Using multiple COM ports under Windows with USB/Serial conversion can be tricky. Modern computers 

generally do not have physical serial ports any more so the software “sees” the serial port through the 

USB/Serial conversion interface of the charger. Sometimes if there is more than one serial device there can be a 

conflict. This is a Windows issue not a problem with the software. The software simply requires a separate 

COM port for each physical charger.  

Normally, for a single charger, the COM port which is set up by default by Windows when you plug in the USB 

adapter is detected automatically and there is no issue, however, particularly if you want to use multiple 

chargers, Windows sometimes sees two identical conflicting devices. The automatic routine should take care of 

this but you may need to manually assign different COM ports to the different chargers. If you need to manually 

specify what COM ports is assigned to each charger for the software to look at you can do that.  
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1. Use Windows Device manager to find out what COM ports are connected to chargers.  Under EOS File menu 
manually add which COM ports to scan.  

2. Then start the program using the Manual COM port selection option. 

Note for experts: 

During startup the Hyperion Suite program default checks all connected units to determine if they have a 

generic Serial ID, if so it will change it to prevent conflicts. You can disable this if you want by adding 

NOCP210 as a command line argument at startup.  

Multiple chargers 

To run more than 1 charger off a USB hub you need to have a Powered USB Hub.  Please note that many USB 

Hubs do not support more then 2-3 chargers even though they are powered, we have found that the Belkin brand 

of USB hubs are good to support multiple chargers.  The software has been tested with >7 chargers on a Belkin 

hub. 

Charger not found 

There are other programs that might interfere with the chargers and lock their COM Ports, The Sony Ericsson 

Phone suite and Nokia Suite are known to cause such problems.  If you find yourself missing a charger or 

cannot find any charger at all, make sure all extra programs that use a serial connection are shut down.  

Mac issues 

This is Windows software but has been tested successfully in a virtualized environment using Parallels and 

Fusion. It also works under BootCamp. Setting up the serial ports is straightforward. Plug in the USB cable and 

just select the virtual windows machine rather than the Macintosh when asked where you want to install the 

USB port. Multiple chargers on a Mac have not been tested but the principles for multiple COM ports under 

Windows should apply.  

Blue screen of death, issues and/or crashing 

It can help to disable power save mode on the USB.  To disable selective USB power save, Figure 37, do the 

following steps in the Control Panel > Power Options > Click on Change Plan settings 
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Figure 37 

Then press on the Change advanced Power settings, Figure 38 

 

Figure 38 
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Finally, Figure 39, browse down to USB settings > USB Selective suspend setting > select Disable > press 

Apply > press OK  

 

Figure 39 
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Known Issues 

Here is a list of known issues as of 2010-12-20  

 None reported. 

Issues with no solution, at this moment:  

 Sync charge must be initiated on Channel #1 for correct name of pack to be reported. 

 When PB Charge ends it shows incorrect Mah/Ah, this is due to design and cannot be corrected at this 

moment 
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Download 
Software: 

The software itself can be downloaded at: 
https://hyperion-world.com/download_files/manuals/Installer.zip  

Current version is: 2011-12-14  

Firmware: 

Visit the EOS CHARGER Firmware Update site for the newest version: 

Do note that v5.5 or later is REQUIRED. 
https://hyperion-world.com/en/firmware_for_eos_line_chargers  

Please read Before you start 

Changes are as follows: 

2011-12-14 

EOS Suite changes:  

 Now support SiLabs 6.5 version, but you can choose to run any version from 6.1-current. 
 This version support Bluetooth module connection if you choose to modify your chargers (see separate 

document) 
 This Suite REQUIRE 5.50 firmware or later. 
 New handling of battery size for the new firmware (Ah meter) 
 All new connection routine for COM Port connection (for supporting BT modules) use BT as command line 

parameter 
 Added a ECO mode for those want to lower the updates per second, nice if you have many chargers connected 

to a slow computer. Use ECOMODE as command line parameter 

Firmware changes: 

 Choosing to charge NiXX type packs when you have connected a Lipo pack via balancer = Error 
 NiXX type of charges will complain if Lipo is connected to balancer cable 
 1420 type chargers now allows for 36 & 48v PB charging. 
 TVC now can be set at lower voltages to use as cutoff. 
 LiXX type of battery now supports up to 100Ah packs. 
 LiXX type of battery shows Ah nomination above 65000mah. 
 PB now supports up to 200Ah packs. 
 Ramp-up of charge now has a slight delay allowing for Generators to catch up. 
 LCD of SuperDuo was updating/flashing too fast. 
 Changes to Buzzer sound (now progress, button and end is separate settings) 
 Internal watchguard function added in case of charger problem it will reset by itself as counter-measure. 

  

https://hyperion-world.com/download_files/manuals/Installer.zip
https://hyperion-world.com/en/firmware_for_eos_line_chargers
javascript:gotoTabLevel1('#before_you_start');
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Contact 
HYPERION HK, LTD. 

UNIT B 3/F HOUTEX INDUSTRIAL BUILDING 

No.16 HUNG TO ROAD 

KWUN TONG, KOWLOON, 

HONG KONG 

tech@hyperion.hk  

Suggestions and bug reports: 

Fredrik Melin 

mel@dacsa.net  

(please add word Hyperion Suite into the title to circumvent the spam-filter)  

Thank you to all Beta-testers who have helped making this release possible.  

A special thanks to John Julian and Mark McCrate for the help with this documentation.  

  

mailto:tech@hyperion.hk
mailto:mel@dacsa.net
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Readme 

Manual Captured on 2020 May 25 from https://hyperion-world.com/en/ecds-man 

EOS Control and Data Suit test version shown in Figure 40.  Find this information by clicking Help > about 

 

Figure 40 

Right-click on any tree item to display the menu in Figure 41. 

 

Figure 41 

https://hyperion-world.com/en/ecds-man
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Click “view details” to see charger name, firmware version and other information, Figure 42.  Another way to see 
firmware information is detailed in the troubleshooting section. 

  

Figure 42 


